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It was a dark and stormy photo...
Well, now that I look at it, it was a little too dark and 
too stormy! How can I fix this? Oh, if only there 
were a simple way  to fix these problems. If only... if 
only... someone would make a simple and easy-to-
understand photo-editing tool. 

Oh look - here's Photoshop! Wait a minute! Wait 
just a minute here. This isn't easy to use! Who 
designed this thing? Did a bunch of German and 
Japanese masochists meet in Yalta to design the 
scariest thing in the world? Yes, yes they did.

And it's been out for over 10 years. Do you think it 
has gotten easier to use, perhaps? Maybe, just 
maybe they  have made it simple and *not scary*? 
No. No such luck. Yes, they  did make Photoshop 
Elements, which is a little less scary  (but it's still like 
being chased around your house at night with a 
homicidal maniac with one knife instead of two).

So yes, I agree that Photoshop is scary. I'll do  my 
best to make sure you know the 10 most important 
things that I use on a regular basis to edit my 
photos.

And yes, I know 1,000 things about Photoshop, and 
I have no need to impress you with a 1,000 bizarre 
tricks that you'll never use. These are the basics, and 
they are all designed to give you the most essential 
tools necessary to give your photos a bit of style.

By the end of this, I  hope you feel less clumsy 
around Photoshop. You'll still stumble around -- no 
doubt! But, at least you'll be able to get your footing 
again before you continue further down this dark 
and twisting path of your future in photography.

SAN FRANCISCO

                   

BEGINNING TIPS
I find that most people that are scared of Photoshop can make one critical change in their 
attitude that will make all the difference. 

BE CHILDLIKE
Do not let the fear of these innumerable unknowns cow you into inactivity. 

As with anything in life, attitude is half the battle. You know this. And, you're probably  on 
the right track just by  getting this eBook (thank you, by  the way). I'll do my best to  help you 
along this path, where you have already taken the first step on your own.

San Francisco at night.  Want to know how to get this view?  Check out my free Stuck 
On Earth app in the iTunes App Store.
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THE MINECRAFT WATERFALL - ICELAND

                   

BAD ATTITUDE THOUGHTS (TRY TO BANISH THEM)
“I'm afraid I'll mess something up!”

You can't... you can always undo or start over.

“I don't know where to click!”
This indicates you're afraid you'll click in the "wrong" place 
instead of the "right" place. There is no right and wrong when 
you are learning. After learning, you figure out the right and 
wrong.

“I just need to do one simple thing and I 
can't even figure it out!"

There is no simple thing. There is no hard thing. The thing is a 
task in itself and every solution from alpha to omega is 
equally inscrutable.

GOOD ATTITUDE THOUGHTS (WELCOME THEM, LIKE A CHILD)
“What does THIS button do?”

Click.

"I made another version, and I will save 
both because they are both pretty!"

"Look! I'm using this tool in a way that's probably completely 
wrong but it's quite fun!"
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KEEP LEARNING FROM KIDS
If you have any kids in your life, keep watching how they 
approach everything.

For example, I  was watching my son play  Minecraft. He was 
playing with another friend over the Internet. Now, Minecraft 
is a game where you are supposed to mine deep into the 
ground to collect rare blocks and use them to build up a little 
house. At least, this is what adults do in the game. It's a very 
adult-way  to think about it. You use these tools to  accomplish 
the goal of building the house.

My son does a little of that, but mostly  he plays with his 
friends in crazy  ways. They  make a pit of lava and then put 
water right underneath it to  see if they can jump into it, get a 
little bit burned, but then survive because they sink through 
to the water level. It's completely inane. But, really, who 
cares? They  are throwing together tools in a strange way  to 
see what happens. 

Raw experimentation with no end-goal should be part of your 
Photoshop experience. If you spend 100% of your time in 
Photoshop trying to accomplish a certain goal, you will often 
end up frustrated, because it's never quite as simple as you 
think it will be. But, if you just experiment wildly, you will 
always be successful.

So, find balance between raw experimentation and goal-
driven work.

     
  

  
  

  
  

  
  

THE AZURE POOL AT HEARST - SAN SIMEON, CALIFORNIA
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PHOTOSHOP ESSENTIAL
SKILL #1: SHARPEN!
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This is a very practical tool. You may  not even know how blurry your 
photos are until you try this trick!

It reminds me of the old joke about the Hubble Telescope. Remember 
how they  launched it and NASA  realized they  had a problem with the 
lens because nothing was in focus? Well, a prominent scientist came out 
and admitted: "Well, folks, we made a mistake. We figured out that the 
galaxy really is blurry."

After you load your photo (File > Open), here is how to sharpen it and 
give it some much-needed pop.

Filter > Sharpen > Unsharp Mask...

Now, who names these things? To me "Unsharp" sounds like "Make it 
More Blurry"! It's one of many  infuriating things about Photoshop and 
the geeks that come up with these names at Adobe.

Anyway, inside you'll see some sliders. Crank up that first slider more 
than you think is necessary  to really  add pop. By default, it won't do very 
much.

Bonus Tip: Click and hold down inside the 
preview square to see a before-and-after 
when you let go.

SHARPEN
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PHOTOSHOP ESSENTIAL
SKILL #2: BASIC NAVIGATION
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When you first open up a photo in Photoshop (depending on the version 
and the window state of your computer), it's likely that the window will 
be there on your desktop, mixed in with all the rest of the mess.

All of those other colors and textures can be distracting while you're 
working on your one photo. Even worse, they  can affect your eye-brain 
calibration about the proper lighting and coloring for your photo.

You can get rid of all those distractions by  hitting F. Press it a few times. 
See how many "states" there are? Yes, 3 states. Windowed, clean 
background with toolbars, and black background full screen.

Every time I open up a photo I hit F to get that clean gray background.

                   

MESSY WINDOWS

CLEAN WINDOW

Perhaps I should have started with this one! But really, navigation is so 
boring, yes? Or, if you are just getting started, maybe NOW is the point 
when you have realized you really  don't even know how to get your act 
around the Photoshop dance floor.

I still see people that are missing a few critical bits about how to make 
basic life in Photoshop easier and more elegant.

THE F KEY
If you're like me, then you have kind of a messy  desktop. Or perhaps you 
have a busy  browser window with 17  tabs open. All of that can be a 
distraction.
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THE Z KEY
Z=Zoom. Simple. Press Z and then click and drag 
right and left. You'll see yourself zoom in and out.

If you click in the center of the photo while zooming, 
it will zoom in on that one area in particular.

When I am in this mode, I  often need to  move the 
photo around if I am zoomed in or perhaps I  simply 
need to reposition the canvas.

THE SPACEBAR KEY
Hold down the spacebar and click and drag. You can 
then place your photo wherever you like.

PROPER LIGHTING AND COLORATION
If you right-click (Apple would be two-finger click) 
on the gray  background, you'll see there are a few 
different options.

Choose Gray, and here's why.

First, note that I  used to  have black all the time. I 
just thought black looked cool and it made my 
images pop with color even more! And, it's true. It 
kind of did. But it also messes with your mind a little 
in terms of the relative light levels and coloration.

Remember that 99.9999% of the world will NOT be 
looking at your photo on your monitor! This means 
the light and color will be dependent upon whatever 
situation their computer has in place.

If you edit in Gray, then your eye will automatically 
use this as a baseline for all your light and colors. 
This will give your photo a much higher chance of 
success of looking good on the monitors of strangers 
who do god-knows-what to their calibration.

BACKGROUND COLOR

     
  

  
  

  
  

  
  

MOVE TOOL
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PHOTOSHOP ESSENTIAL
SKILL #3: CROPPING
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Very rarely do we get the perfect photo in camera. It takes a little work!

By the way, this does not really  speak to "Composition," which is a 
subject covered by  one of my  other best-selling eBooks called 
"Composing the Photo" - you can get that at Flatbooks right now if you 
are interested.

You can begin the crop by clicking the Crop tool there on the left. The C 
key also works. 

Now here's a few other cool ways to use crop. The second one is not so 
obvious, but I use it on at least half of my photos.

First, you can rotate the whole photo while cropping. After you draw the 
new cropping rectangle, if you move the mouse pointer just outside of 
one of the corners, you'll see it gets the rotate/spin shape. Just hold 
down and move to rotate/spin.

Second, and here is the cool one, try  clicking the "Perspective" checkbox 
on top. You can then move individual corners. You can do this to align 
things horizontally  or vertically. If your horizon is not quite right or a 
vertical plane is a little bit slanted, this is a very quick way to  correct the 
problem. 

This often works better than rotation, since rotation may  fix one part of 
a photo but mess up another.

CROP

                   

Simply  draw a new box  around the image with the new crop. You can 
adjust by  using the grippies on the top and bottom. When you hit 
ENTER (Return) the photo will be cropped.

The museum of natural history in Paris is a great place to visit that 
hardly anyone knows about! The displays are incredible, and if you are 
into science, you could easily spend the whole day here. It's great for 
kids and adults. It's especially great if you're also into photography!

THE SECRET LAIR OF JULES VERNE - PARIS, FRANCE
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CROPPING

     
  

  
  

  
  

  
  

THE LONG ROAD TO NEW ZEALAND
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PHOTOSHOP ESSENTIAL
SKILL #4: LAYERS
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Over on the right is a very  important panel called "Layers." As you start 
working on a photo, you may  end up with many  different layers. Think 
of them like sheets on a bed. You only see what is on top.

As you start having multiple layers, you may find it necessary  to  re-
arrange them. You can do this by  simply  clicking and dragging to their 
new spot in the order.

Note that you won't be able to move the bottom layer until you get rid of 
that "padlock" icon. You can do that by simply dragging it to the trash.

In this example, I wanted to show how layers worked. I made a copy of 
the current layer, desaturated, and added a big white area to the bottom. 
I don't know why  I did this particular style of defacing -- I  just wanted it 
to look different. Anyway, let's not obsess on the strange nature of my 
defacing -- this is just an example to  show how some things can be on 
top of other things.

In the next example, you can see how I took the layers and re-arranged 
them so that a different one appears.

Bonus Tip 1: If you toggle the little eyeball to 
turn it off, the layer will be invisible.

Bonus Tip 2: If you find that you are hiding/
showing a layer a lot, why not go to 
Keyboard Shortcuts and make it a hotkey! 
This is one of my most-used hotkeys! I'm 
often masking through to the layer beneath 
(covered soon). I use Command-1 to hide-
show the layer. It's very handy!

                   

LAYER ORDER SWITCHED
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Once you learn masking, you'll use it often to sharpen, re-light, or repair one area of a photo.  In this photo, I had to sharpen the bullfighter.

THE BULLFIGHTER - NÎMES, FRANCE
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PHOTOSHOP ESSENTIAL
SKILL #5: SATURATION
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Is your photo  too colorful or not colorful enough? Here's an introduction to  the 
adjustment panel using an example of saturation.

You'll see a new panel here on the right called "Adjustments." Inside, you'll see all 
kinds of intimidating hieroglyphics that would confuse even the Rosetta Stone.

One of these squigglies is the "Saturation" adjustment. When you click on it, you'll 
see this whole panel transform itself into  a set of controls related to this change. The 
sliders are for Hue, Saturation, and Lightness.

For this example, I  want to  make this Blade Runner-esque photo less colorful. I feel 
like the colors are a little too much, so I will desaturate it.

When I click on the Saturation control in the adjustment panel, you'll see it adds a 
new "layer" on top. Note that this indicates there is an adjustment being done.

In this case, I will drag the saturation to  the left, which will take away  some of the 
color.

And this is how the adjustment panel works! Just pick a type of adjustment (in this 
case, Saturation), move the sliders and then bam! You are done.

ADJUSTMENTS
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DARKNESS IN THE CITY - SAN FRANCISCO, CALIFORNIA
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Curves are a simple way to adjust the lighting for your photo.

I often use curves to:

1) Increase the "meaningful" contrast in the photo (as I  do 
in this example)

2) Increase the brightness or

3) increase the darkness.

Sometimes, when I am done with a photo, the whole thing will feel just 
"too bright," so I will jump into curves and make it a bit darker until it 
feels right. As with everything, there is no "right" way to use curves, but 
the more you edit the photos, the more you will feel natural when 
making adjustments.

To use the tool, go select the Tools hieroglyphic from the Adjustments 
panel. You'll see a scary-looking grid appear with a slanted line across it. 
This straight line, believe it or not, is your "curve." Well, it will be a 
curve once you curve it.

To curve it, click on any  part of the line, and you can drag it into a curve 
of one shape or another. See how that works? Pretty  simple, eh? Play 
with it for a while to see how it affects the photo.

     
  

  
  

  
  

  
  

You may  notice that each time you click on the line, you get another dot 
-- another bendy-spot on the curve. If you find you have too many  dots, 
you can make them go away by just dragging them off the grid.

To increase the contrast, as in this photo, you can make a simple "S-
curve" - these start out with the lower dot a bit to  the right and the 
upper dot a bit to the left. This will darken the darks and brighten the 
brights. Oftentimes, this will add more color and "punch" to the final 
image.
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AFTER

     
  

  
  

  
  

  
  

BEFORE

ZIPPING THROUGH TOKYO - TOKYO, JAPAN
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Did you know the word "history" came from antiquity  -- a combination 
of "his" and "story"? This has nothing to do with Photoshop, but I just 
thought it was interesting…  and if women had ruled the world, we might 
just be talking about the Photoshop Herstory Panel now.

Anyway, the history is a great way  to access multiple stages of "undo."  
The History  panel can have a very  long list of things you've done.  The 
more memory you have in your computer, the longer this list.

If you want to  go back in time, simply click inside the history panel and 
click on the step you'd like to return to.

HISTORY

     
  

  
  

  
  

  
  

If you use the history  a lot, you may  want to drag it over to one of your 
main panels along the right side.  Once you do this the first time, you 
may  realize another larger part of Photoshop -- you can drag windows 
around and customize your panels.  If you never use "Swatches" for 
example, just drag that window out and close it.  

If you ever delete a panel and want to get it back, no problem!  Just click 
Window in the menu bar and select the name of the panel that is gone.
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BUSTLING BEIJING - BEIJING, CHINA

     
  

  
  

  
  

  
  

You can use the history to go back and forth to see if you like your curves adjustment.  In this case, by making a bigger s-curve, I was able to 
help the colors pop a little more.
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ELECTRIC LA AT NIGHT - LOS ANGELES

     
  

  
  

  
  

  
  

And while we're talking about Curves, here's another tip.  In photos, the stronger the blacks, the stronger the colors.  If your photo and colors feel a 
little flat, try using Curves to increase the depth of the blacks.
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This one is a bit advanced, but it does come in quite handy  to repair 
parts of photos that may need some repair or enhancement.

If you have taken a wide-angle photo, for 
example, you may notice that bits near the 
edges are warped and look strange. In the 
case here, the mysterious time-traveler in 
the overcoat has been warped a bit by  the 
lens.

Let's warp him back.

This is a bit of a multiple step trick that 
i n c o r p o r a t e s s o m e t h i n g c a l l e d 
"Transform," which is the first step before 
"Warp."

Start by selecting everything: Edit > Select 
All

Then begin the warp by  selection: Edit > 
Transform > Warp

You'll be given a grid where you can drag 
around little bits to Warp the image. In 
this example, you can see how I have 
"squeezed" the man back into a natural 
human shape.

When you are done, hit Enter (Return), 
and you're good to go.

Note that you may  have to re-crop 
your image to get rid of the dead 
space your warping might have 
caused on the edge of the photo!
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Do you have pesky  little bits of your photo that need to go away? Here is 
a list of things (in order of most common) that I routinely  have to delete 
in photos:

• Little bits of sensor dust that darken little spots here and there.
• Telephone lines
• Telephone poles
• Small birds in the sky that look like they could be dust
• Elements of the photo  that are distracting or otherwise take away 

from the overall feel

In older versions of Photoshop, the main way  to  do this was with the 
"Clone/Stamp" tool. Sure, you can still use that, because much like the 
labyrinthinal tax code: things never go away.

It's better to use the Spot Healing Brush with the new Content Aware 
Fill. This is the default setting for the Spot Healing Brush, which you 
can find over in the toolbar.

If you do NOT see the Spot Healing Brush, you might have a different 
tool displayed in its place. Most of the tools have multiple selections that 
will appear if you hold your mouse button down over a tool.

Make a little dab or stroke with the brush, and you'll see that area auto-
replaced by elements from the surrounding area. 

HINT: ADJUST THE SIZE OF YOUR BRUSH EASILY
I'm constantly  changing the size of my  brush. This works for the normal 
brush or for the this Spot Healing Brush we are discussing. To quickly 
adjust it, get to know the left and right bracket keys: [ and ].
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The Spot Healing Brush usually  does a great 
job unless there is a very complex situation. 
If it doesn't replace the brushed area with a 
good choice, brush again over the part it 
messed up. Then do it again. Chances are, 
the area where it messed up will get smaller 
and smaller.

For example, in the image here of this beach 
in New Zealand, I  had to brush over that 
area 3 times until that l itt le rock 
disappeared. Each time I brushed, the there 
was less and less to brush.

     
  

  
  

  
  

  
  

BONUS TIP: You can also use this "Content Aware Fill” on a 
much bigger area than just a brush stroke. Try choosing the 
Rectangle Marquee Tool (if you want to fill a rectangle), 
create a box, and then go to Edit>Fill… In there, the default 
choice should be Content Aware. It will fill that box 
intelligently.

BONUS TIP USAGE: Remember that Warp trick from #8? 
Remember how it created some messy white/transparent 
area in the left? This would be a good situation to use the 
Bonus Tip above to intelligently fill that dead area with 
more photo.
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FINAL RESULT

     
  

  
  

  
  

  
  

THE MYSTERIOUS MOERAKI BOULDERS - SOUTH ISLAND, NEW ZEALAND
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If you want a simple way  to give your photos some special looks, lets 
start experimenting with Lighting Effects. I'm just going to show you 
one trick here. If you go about this the right way, then you can 
experiment with hundreds of variations.

1. Duplicate the current layer that you are working on. You can do 
this by  right-clicking on the layer in the layers panel. Not 
working? Try  clicking in a different part of that layer in the 
layers panel! Some areas accept the right click in different 
ways… annoying, I know!

     
  

  
  

  
  

  
  

2. Go to Filter > Render > Lighting Effects

3. Grab the grippies on that oval (not so easy, btw), and twist it 
around to  get a lighting adjustment that is interesting on your 
photo. I'd suggest making the brightest part of the light on the 
most interesting bit.

4. Click OK

5. Now you have a new layer with the lighting effect, but it is 
probably  too extreme, so let's dial it back. One way  to dial it 
back is to change the "blend mode," which is that little drop-
down in the layers panel you may  have missed. Try  "Screen" or 
perhaps a few others.

If the effect is still too strong, try adjusting the Opacity of that one layer.

The more you play with these lighting effects, the more you can add 
something special and unexpected to your photo!
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LIJIANG AT NIGHT - LIJIANG, CHINA
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Masking is an important skill to learn.  I've put together a series of screenshots here to talk about the positioning of various 
elements so you can see how it is done

THE MOST BEAUTIFUL ROAD IN THE WORLD - QUEENSTOWN, NEW ZEALAND
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Here is the image in Photoshop before we start working with it using masks
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In addition to Photoshop, I use a tool called Photomatix  Pro almost every  day  to process High Dynamic Range (HDR) photos. You can 
learn how to  use Photomatix  yourself via my free HDR tutorial or the video version of the tutorial with over 11  hours of step-by-step 
instruction. If you decide to buy Photomatix be sure to use the STUCKINCUSTOMS discount code to save 15% at checkout.
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BONUS SECTION: THOUGHTS ON PHOTOSHOPPING
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There are some people out there that will make you feel bad about 
Photoshopping things. Don't listen to them. Chances are they  have a 
great deal of psychological baggage that is causing them all sorts of 
issues in life, and this virulent anti-Photoshop mentality  is just one of 
the happenstance manifestations.

See, you and I  -- we're a team. We'll fight the forces of anti-Photoshop 
darkness together. Do not listen to all these people out there that are 
against the use of a tool. Think of the Council of Candles and how upset 
they were when that pesky lightbulb came along.

Let's look at a great example of why  Photoshop is perfectly  okay. This 
will be a great arrow for your quiver in your next battle with one of 
these slackjawed neckbeards.

You'll often hear a statement that is laced with condescension like, "Oh, 
you see, I [they  like to stretch out the word I in a sing-songy voice to let 
you know this is the epicenter of their statement] prefer to get the 
photo perfect in-camera." Try  not to roll your eyes when you hear this, 
because that will just make them mad.

Instead, consider this. Think about all the things that lighting-people 
go through before the photo is taken. They  set up strobes, umbrellas, 
softboxes, they  have assistants holding reflectors - the list is endless. 
Now, of course there is nothing wrong with any of that, but there is 
certainly - *a lot of work goes into artificially lighting a scene.*

So, if you are doing your artificial lighting of a scene later in 
Photoshop, what is the difference? In fact, the time at which you 
apply  the artificial lighting is completely  arbitrary. Who cares if 
you do it before or after the click?

I'll tell you who cares: people that do it before the click. They 
somehow find their artificial lighting as more pure. No doubt it 
takes a lot of work and a lot of smarts, but that does not mean it is 
superior.

In fact, we are on the more open-minded side of the argument. I 
bet none of us have a problem with any  of that artificial lighting 
before the click. We see the point-of-artificial-lighting to  be 
completely  arbitrary. As opposed to the other camp, however, we 
know there is nothing wrong with adjusting the photo in 
Photoshop after the click?

Let's also note, for the sake of fairness, that not all the artificial-
lighting-before-the-click camp are anti-Photoshop. Just the 
annoying ones.

THE DOCK IN THE DESERT - BURNING MAN, BLACK ROCK 

DESERT, NEVADA
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TOOLS AND PLUGINS

OTHER BONUS TIPS!
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Don't feel like you need to "master" Photoshop before you get plugins! 
In many cases, plugins can make Photoshop even easier to use.

I know a great number of people that don't even really  use Photoshop 
EXCEPT to use the Plugins! Some are as simple as "Instagram" - others 
have much more flexibility and style.

I use many many  plugins, and I'm always adding new ones to  my 
arsenal.

Rather than burn them into this eBook, I want to keep it as a living 
document. Visit my Review Page at

http://www.stuckincustoms.com/reviews 

Start with just one or two. You don't need them all, of course. If you are 
familiar with my  "HDR" look to  my photos, maybe you want to start 
with Photomatix. Then maybe you can try something one of the other 
plugins mentioned on that page!

You'll have so much fun with these plugins… really! 

     
  

  
  

  
  

  
  

- Sharpness Allocation - not all parts of your photo should be equally 
sharp. In other words, in the sharpening phase, you may not want to 
sharpen the entire thing. Instead, consider sharpening just the 
important parts, because the viewers eye will hang out there longer. You 
can do this using the masking technique from the bonus chapter.

- File Formats - I  prefer to  save my final image as a JPG with the 
maximum quality  (12). This is what goes into  my  portfolio. It's perfect 
for printing or display  on monitors. I know many other professionals 
that agree with me on this. You'll find some professionals that argue 
that TIFF is superior. I've looked at both at the micro-pixel level… and I 
consider myself to be very  skilled in the art of color and fidelity, and I 
can see no difference.

- Image Processor - Wow this is a handy  tool. I  use it almost every day 
to convert images from one format to another! Now, maybe this is a 
particular thing for me, because I feel like I'm always having to send 
one group or service a set of images in a certain size. You can access 
this via File > Scripts > Image Processor… Inside there, you can tell it 
to scour through all the files in one directory and convert them to 
another format.

- Hang on to the PSD? I don't. BTW, the PSD is the file format for 
Photoshop. It will not only  save the photo, but it will save all the layers. 
Note that many graphic designers and others may  choose to save the 
PSD with all the various layers so they  can come back and make 
changes for clients down the road. That's okay. But, for my  photos, they 
are done when they are done. 

THE LI RIVER - GUILIN, CHINA
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MY FAVORITE HOTKEYS
I use many of the pre-set hotkeys, but I also customized a few that I use quite a bit:

  WWW.FLATBOOKS.COM        PAGE 36     
  

  
  

  
  

  
  

Spacebar

[ and ]

Cmd-1

Cmd-R

F 

Cmd-T

Cmd-S

moving the photo about

adjusting the brush size

(custom)hide/show layer

(custom)create mask on layer

Toggle full screen modes

Transform (from where you can r-click to Warp)

Save. I do this a lot… So should you. You never 
know when sweet lady Photoshop will crash and 
burn.
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A BIG THANK YOU FROM THE RATCLIFF FAMILY!
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I hope you enjoyed this eBook. Not only 
do they take a long time to make, but they  

have taken me many years of toil and 
expertise (and hundreds of mistakes!) to 

make this possible.

Many Bothans died to bring you this 
information.

Visit flatbooks.com to see the latest 
offerings, and I would LOVE to hear your 

feedback!
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ENJOY SOME SAMPLES FROM 
OUR OTHER EBOOKS
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"JUST DIFFERENT" 
VERSUS 

GRADATIONS OF 
PERFECTION

A master 's eye wil l a lways be 
considering the meta-

analysis of photography.

That is, you will always be keenly  aware of your 
attitude and approach to a photograph, even while 
fully  in the moment.  Imagine yourself a sorcerer, 
with the ability to have multiple cogent cycles of 
t h o u g h t , e a c h o f w h i c h i s c o m p l e t e l y 
compartmentalized, yet being aware of one another 
with a delicate tether of meta-information.

While composing a photo, keep a steady tally of the 
main objects involved with the composition.  Keep 
ranking them as "more interesting" and "less 
interesting."  Imagine you are at the eye-doctor with 
the old "better/worse" test.  You know, when the 
doctors perform this test, they have multiple levels 
of testing to make sure you are consistent.  
Sometimes people just say "better" or "worse" 
without even really knowing -- they just feel 
pressured to say these things.  So, doctors have come up with a 
system to make sure there is consistency so they don’t prescribe the 
wrong thing.

The way  you can be your own eye-doctor when composing is to 
recall the transitive property of numbers.  You might remember 

from high-school algebra the notion that if A is greater than B, and 
B is greater than C, then A is greater than C.  Inevitably, you'll be 
dealing with various objects in your photo.  As you move around to 
consider the composition of these objects, you will be choosing 
whether or not to include them.  Perhaps you will be considering 
how prominent of an "actor" to make the object in the scene. If you 
are looking at three objects in a scene, you may  determine that 

Actor One is better than two.  And Actor Two is 
better than Actor Three.  Check yourself to ensure 
that Actor One is better than Actor Three.

It's not always that easy.  Maybe combining Actor 
One and Actor Three is stronger than Actor 
Two alone.  It will behoove you to be 
somewhat scientific and analytical when 
putting together a scene.  This needs to 
work in concert with your artistic side 
without skipping a beat.  That is, you need to 
artistically assess the scene and then scientifically 
rank it against other scenes.  This interplay 
between the left and right brain is a tremendous 
challenge and quite fun.

You might think this sounds like "overkill,” but I 
ask you to reconsider the days and weeks great 
painters went through when putting together 
a still life.  Every object has its own 

beautiful place.  If you are lazy, the viewer will know.  
Some people cannot tell the difference between a 
thinking photographer and a lazy  photographer.  
But those people do not matter.  The people 
that matter can tell when you are being lazy.

THE HORSESHOE
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